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INTRODUCTION 

Welcome to Speed Reader II for the Apple Macintosh. 

The six Speed Reader II exercises will help you improve your reading speed, 
your comprehension (how much you understand while you’re reading), and 
your retention (how much you remember afterward). It will also make reading 
easier and more enjoyable. 

The exercises will help build the skills you need for rapid, efficient reading. 
You'll be able to | 

- broaden your eye span (peripheral vision) 

- increase your rate of perception (speed of recognition) 

- train your eyes to move efficiently across a page, without wandering, 

‘Slowing, or regressing. 

These techniques are simple to practice and relatively easy to master. They’ve 
worked for thousands of people, and you'll be surprised at how soon they'll 
start to work for you. 

Speed Reader II was tested on high school and college students at the Upward 
Bound educational facility in Palos Verdes, California. In private sessions under 
an instructor’s direction, all Upward Bound students at least doubled their 
reading speeds. Most students tripled, and some even quadrupled their reading 
speeds. These spectacular gains in speed were made while students maintained 
or improved their comprehension levels. 

The Apple Macintosh is the ideal computer for building your reading skills. 
Because no typing is required during the actual lessons, the Macintosh lets you 
focus entirely on improving your reading skills. Speed Reader II takes full 
advantage of the Macintosh’s windows, icons, and flexible screen design. 

This manual will tell you everything you need to know about using Speed 
Reader II to improve your reading speed. You'll find the program extremely 
easy to use—and the manual valuable as a reference guide and course outline. 

If you’re not comfortable with the basic operating procedures for the 
Macintosh, please review Apple’s Macintosh Tutorial before using Speed Reader 
IT. 

1 INTRODUCTION 



GETTING STARTED 

What You'll Need 

To use this version of Speed Reader I/, you'll need 

- an Apple Macintosh with at least 128 K of memory 

- the Speed Reader I/ disk. 

If you want printed copies of Speed Reader ITs reports and graphs, you’ll also 
need a printer. 

Back-up Copies 

Speed Reader II is copy-protected. However, you may make a copy of it as a 
“demonstration program’’ which will allow you to use all the activities with 
limited reading selections. 

You may order a back-up disk for $10 from 

Davidson & Associates, Inc. 

6069 Groveoak Place, #12 
Rancho Palos Verdes, CA 90274 

You must either send in a warranty card, or already have a warranty card on 
file with Davidson & Associates, Inc., in order to purchase a back-up. 

There is a one-year warranty on Speed Reader II. If you have a warranty card 
on file, Davidson & Associates, Inc. will replace any damaged or 
malfunctioning disk, free of charge, for one year from the date of purchase. 

2 GETTING STARTED 



Starting Speed Reader II 

To start Speed Reader II. 

- Turn on the computer. 

- Place the Speed Reader I/ disk in the drive. 

In a few seconds, you'll see the Macintosh Finder screen: 

SR System B= 

15 items 379K in disk 20K available ee ee ee ee 

System Folder Empty Folder Speed Reader II 

<i 
j Reading Passages Editor 

Double-click the Speed Reader I7 icon. You'll see a screen displaying all six 
Speed Reader II exercises: 

3 GETTING STARTED 



File Exercise Help 

Warm-up Words 

: t 

_ by doel Cannon 
and Jan Cavidzon, Pht. 

Timed Reading 

This is the main screen. Each time you complete a Speed Reader II exercise— 

or if you leave an exercise before completing it—you’ll come back to the main 

screen. 

Help 

The Help menu will give you more information about speed reading, as well as 

directions for using specific exercises. 

- Pull down the Help menu. 

. For basic information on starting to use Speed Reader Il, select Getting 

Started. 

- For information about a specific exercise, click the appropriate icon on 

the main screen, pull down the Help menu, and select Directions. 

- To learn how a specific exercise will improve your reading skills, click = 

the appropriate icon on the main screen, pull down the Help menu, 

and select Theory. 

4 GETTING STARTED 



Signing In 

To sign in for the first time: 

- Pull down the File menu. 

. Click the word New... 

New Student Name | $R System 

Eject | 

Save : Drive 

- Type your name. 

- Click Save, or press the Return key. 

The next time you use Speed Reader II, you'll pull down the File menu, select 
Open, then click to open the file with your name, or double-click the student 
file icon from the Finder screen. 

If this is your first experience with Speed Reader I/, start with the Timed 
Reading exercise. Double-click the Timed Reading icon. 

5 GETTING STARTED 



TIMED READING 

Timed Reading lets you read a passage at your own pace. At the end of the 
passage, you'll see your reading rate displayed. Then you'll take a quiz to test 
your comprehension level. Your score includes your reading speed in words per ¢ 
minute (wpm) and your comprehension level. , 

Using Timed Reading 

Double-click the Timed Reading icon. A dialog box will appear on the screen. 

A-Workaholics 
B-Extreme Skiing 

C-The Egg 

D-Trained Dog . Hepeat 

E-Christmas in July 

G-Computer Age Orange : 

[ Eject 

‘Drive | 

To begin: 

- Click a title. 

- Click Open. 

- Click Ready to see the first page. 

- Click to ‘turn the page.” 

+ After reading the passage, click once to see your reading rate. 

To take the quiz: 

- Click to begin. 

- Click the correct answer (A, B, C, or D), or type the answer. 

- If the question mark is still visible, your answer is incorrect. Try again. 

6 TIMED READING 
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- When a correct response is given, an icon will appear in the box at the 
bottom of the screen: 

Right the first time! 14 

Right on the second try. 4 

Right on the third try. % 

Right on the last try. L 

When you've answered all the questions, the scoreboard will display your score: 

Granny Smith 

Timed Reading 

285 wpm racw/ 

A-Workaholics 

| Record | 

- Click Record to save your score. 

- Click Cancel to return to the main screen. 

Now you’re ready to begin improving your reading skills. Double-click the 
Warm-up Letters icon. 

7 TIMED READING 



WARM-UP LETTERS 

_ In the Warm-up Letters exercise, two letters will appear on the screen. If you 
correctly recognize these letters, the next group will appear for a briefer period 
of time. As you progress, the display time becomes increasingly brief. After you 
have mastered two letters, you will be challenged by three, and then four 
letters. 

This exercise will widen your eye span and increase your rate of perception. 

Eye span (or peripheral vision) is a measure of how many letters or words 
you can recognize at one time. As you advance from two letters to three, and 
from three to four, you are learning to utilize your peripheral vision more 
effectively. Your rate of perception is the speed at which you recognize letters 
or words. As you work through each level of Warm-up Letters, your rate of 
perception will accelerate. 

Remember, this is a warm-up—not a test. Don’t worry if you miss a lot of 
letters at first; Speed Reader I/ will let you try until you get them right. 

8 WARM-UP LETTERS 



Using Warm-up Letters 

There are three levels in the Warm-up Letters exercise—two letters, three 

letters, and four letters. The screen shows one thermometer for each level: 

@ File Exercise Help 

Warm-up Letters 

@) UPPERCASE 

© lowercase 

- Click the Uppercase or Lowercase button (you'll probably find 

uppercase letters easier to recognize). 

- Get ready to focus on the target and read the letters that follow: 

- Click Ready. 

- Read the letters that appear. 

Two columns of letters will be displayed. 

- Click the appropriate letter in each column (or type the letters). 

- Ifyou select the correct letters, the mercury in the thermometer will rise. 

- An incorrect selection will cause the mercury to fall. 

9 WARM-UP LETTERS 
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As the mercury rises, the display time decreases. When the mercury reaches the 
top, the thermometer will ‘“‘explode,’’ sending you on to the next thermometet. 

To go faster: 

- Drag the mercury upward with the pointer. 

To change the number of letters in the exercise: 

- Click the stem of another thermometer. 

To start again after an interruption: 

- Click Ready. 

Remember to focus on the target. Don’t move your eyes from side to side. Use 
your peripheral vision to take in all the letters at once. 

To leave Warm-up Letters: 

- Click the close box in the upper left corner of the screen. 

- Click Record to save your score. 

Return to the main screen and double-click the Warm-up Words icon. 

10 WARM-UP LETTERS 



WARM-UP WORDS 

The Warm-up Words exercise is similar to Warm-up Letters, except that it 
challenges you with words instead of letters. It will further challenge your eye 
span and sharpen your perception. 

Using Warm-up Words 

The three thermometers indicate a choice of two words, three words, or four 

words. 

Drag the mercury up or down the thermometer to increase or decrease your 
speed. To change the level of difficulty, click the stem of the appropriate 
thermometer. 

To begin the Warm-up Words exercise: 

- Get ready to focus on the target and read the words that follow. 

- Click Ready. 

- Click the appropriate word in each column (or type the first letter of the 
word). 

To leave Warm-up Words: 

- Click the close box. 

- View your score and click Record to save it. 

The remaining four Speed Reader I/ exercises use actual prose passages to help 
you improve your reading skills. To begin, double-click the Column Reading 
icon. 

11 WARM-UP WORDS 



COLUMN READING 

The Column Reading exercise builds on the skills you practiced during the 
Warm-up exercises. In the Column Reading exercise, the computer will 
highlight groups of words as you read down a column of prose. You will use 

your wider eye span as you read down the column in groups of words. You'll 

be able to increase your reading speed by gradually increasing the speed of the 
passage. 

Using Column Reading 

Double-click the Column Reading icon. This dialog box will appear: 

A-The Inefficient Reader 

B-The Efficient Reader | | SR System 
C-Eye Movements 

D-Peripheral Vision Hepeat ) 
E-Flow of Meaning 

G-Avoiding Regressions 

12 COLUMN READING 



The first ten passages listed are about speed reading. The last ten passages are 
on a variety of interesting topics. 

- Click to select a passage, then click Open. 

- The speed you see is the rate you established during Timed Reading. It 
may have been adjusted upward or downward depending on your 
comprehension score. You may change it if you wish. Click OK. 

- Adjust the column width by pointing to the size box in the lower-right 
corner of the column. 

- Press the mouse button and drag left to narrow the column, right to 
widen it. 

- When the width is satisfactory, release the mouse button. 

- Move the pointer off the column so it won't distract you while you read. 

- Get ready to-read each highlighted line. 

- Click Ready to start the exercise. 

- Read the passage and take the quiz to test your comprehension. 

- Record your score. You may repeat the passage, select a new one, or click 
Cancel to return to the main screen. 

The Eye Movement exercise is a natural follow-up to the Column Reading 
exercise. 

IS COLUMN READING 



EYE MOVEMENT 

In the Eye Movement exercise, you will read groups of highlighted words 
across an entire line. This exercise will train you to move your eyes 
rhythmically from one group of words to the next. You will be able to select 
the number of pauses per line. 

During the Eye Movement exercise, your eyes should pause only once on each 
group of words. Your head should remain still; do not move it from side to 
side. 

The closer you can come to these goals, the more you’ll benefit from the 
exercise. 

Using the Eye Movement Exercise 

Eye Movement opens with a dialog box listing the passages that are available. 

To begin Eye Movement: 

- Click to select a passage. 

- Click Open to start the exercise. 

Now you'll be able to specify exactly how you want to read the passage: 

Eye Movement 

Words per minute: 

Pauses per line: 

SEO 2 

14. EYE MOVEMENT 



To change the speed and number of pauses per line: 

- Type in the new speed. 

- Click the button to choose the number of pauses per line (four, three, or 
two). 

- Click OK. 

- Get ready to read each phrase as it is highlighted, and let the 
highlighting guide you through the passage. 

- Click Ready to begin. 

- Read the passage and take the quiz. 

- After the quiz, your score will appear. 

- Click Record to save your score and return to the Eye Movement dialog 
box. 

It’s very important to adjust the reading rate and eye span to your own reading 
patterns as you go through an exercise. If you find yourself trying to read 
ahead of the program, set the speed at a faster wpm (words per minute). If 
you find phrases disappearing before you have grasped them, reduce the speed 
slightly. If you find it easy to read the whole group of words without moving 
your eyes, increase your eye span by reducing the number of pauses per line. 
Try to push your speed a little higher each time you do an Eye Movement 
exercise. 

From the Eye Movement dialog box, you can 

- select another passage, or 

- click Cancel to return to the main screen. 

At the main screen, double-click the Paced Reading icon. 

15 EYE MOVEMENT 



PACED READING 

Paced Reading gives you the opportunity to combine the eye span and 

perception skills you’ve developed so far. You'll be reading longer selections at 

a preset pace. The effect is like reading a book while someone else turns the 

pages. 

Using Paced Reading 

When you double-click the Paced Reading icon, a list of passages will appear. 

- Click to select and open a passage. 

- Set your speed and click OK. 

To adjust the window size: 

- Point to the size box in the lower right corner of the window, and hold 

down the mouse button. : 

. Drag the size box up or down to increase or decrease the number of lines 

that appear on the screen at one time. 

When the window size is satisfactory: 

- Get ready to read the passage. 

- Click Ready to see the first page. 

- Read the passage and take the quiz. 

- Record your score. 

- Return to the dialog box to repeat the passage, select a new passage, or 

return to the main screen. 

16 PACED READING 
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CHECKING YOUR PROGRESS 

Return periodically to the Timed Reading exercise to learn how much your 
speed and comprehension have improved. 

To measure your progress: 

- Double-click the Timed Reading icon. 

- Select a new passage. 

- Read the passage. 

- Take the quiz. 

- Record your score. 

A 
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GETTING A REPORT 

Speed Reader II will keep a record of your progress during each session. You 
may view your scores on the screen, or print out the report. 

To get a report: 

- Pull down the File menu. 

- Select Report. 

The report displays all the exercises that you recorded for each session: 

Speed Reader || 

Progress Report 

Johnny Appleseed 

Session #1 flom, Mar 11, 1965 1342 PH 

Timed Reading - A-Workaholics 

Warm-up Letters- 2 Letters 

Warm-up Letters- 3 Letters 

Eye Movement - A-The Inefficient Reader 

Eye Movement = C-Eye Novements 

Paced Reading - B-Extreme Skiing 

Session #2 Tue, Mar 12, 1985 1:26 PI 

Warm-up Words 2 Words 

Warm-up Words 3 Words 

If the report extends beyond one window, use the arrows on the scroll bar to 

see more. 

18 REPORT 
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To print a report: 

19 

- Make sure your printer is on-line and has paper. 

- Pull down the File menu. 

- Select Page Setup. 

- Click the buttons to select paper size and orientation. 

- Click OK. 

- Pull down the File menu again. 

- Select Print. 

- Click the buttons to specify quality, page range, number of copies, and 
paper feed. 

- Click OK to start printing. 

REPORT 



GETTING AND INTERPRETING A GRAPH 

Speed Reader I will graph your scores for any of the six exercises. It can also 

print a copy of each graph for your reference. _ 

To see a graph of your scores: 

- Go to the main screen. 

- Click once on one of the six exercise icons. | 

- Pull down the Exercise menu. | 

- Select Graph from the menu. 

A Warm-up Letters or Warm-up Words graph will display one column for each 

level you have attempted. The height of the column indicates the speed you 

reached for that exercise. The pattern of the column indicates the number of 

letters or words in that level. | 

Speed Reader II 

~ Newton Pippin 
Warm-up Words 

20 GRAPH 
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A reading exercise graph will display one column for each Timed Reading, 

Paced Reading, Column Reading, or Eye Movement passage you've read. The 

height of the column gives your reading speed in wpm (words per minute). 

The pattern of the column indicates your comprehension level. 

Speed Reader I! 

Goldie Delicious 
Timed Reading 

Reading Selections . 

Comprehension [_]0®% 258 50% ee 75% Mi 100% 

To see a graph of your scores for another exercise: 

- Click the close box to return to the main screen. 

- Click another icon. : 

.» Pull down the Exercise menu and select Graph. 

To print a graph: 

. Make sure that your printer is on-line and has paper. 

- Pull down the File menu. 

- Select Page Setup to specily paper size and orientation. 

. Select Print to specify quality, range, copies, and feed. 

- Click OK to start printing, 

Zl “GRAPH 



CREATING STUDENT RECORDS 

To create a new student file: 

- Pull down the File menu and select New. 

- Type a name into the box. 

- Click Save. 

If a file has already been created: 

- Pull down the File menu and select Open. 

- Select a name from the list. 

- Click Open. 

Each student file you create will appear on the Finder screen as an icon: 

From the Finder screen, you can enter Speed Reader II by double-clicking the 
icon for the student file you want to use. 

22 STUDENT RECORDS 



A SELF-STUDY COURSE USING SPEED READER II 

Principles of Speed Reading 

Reading involves both the eyes and the brain. The six exercises in Speed 

Reader II will strengthen and train your eyes to help you read more 

efficiently. As you work through each exercise, Speed Reader I/ tests your 

comprehension to make sure your brain and eyes are working together. 

Before you begin the Speed Reader II self-study course, let’s look at what 

occurs when you read. 

Your eyes do not move smoothly and continuously across the printed line as 

you read. They move across each line in irregular spurts: they pause, focus, 

move quickly, pause, focus, and move again. 

Each time your eyes pause, they recognize a word or group of words, sending 

the image of the printed word or words to the brain to be decoded into 

something meaningful. Each time your eyes move, they are not reading but 

merely getting into position to pause and read the next word or group of 

words. 

Weak or sluggish eye movements can slow down your reading. Look at the 

following examples; the dots show where the reader pauses, and the lines 

show how many words the reader sees during each pause. 

@ ® S @ @ @ @ 

(Fer ee NE AN ed 
The inefficient reader reads word by word. 

ee er eee rl 
The efficient reader reads several words 

Piece oh 2 a 
each time his eyes pause. 
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The fewer pauses you make per line, the faster you will read. The less time you 

spend on each pause, the faster you will read. And the more efficiently your 

eyes move from one group of words to the next, the faster you will read. Thus, 

your reading rate is affected by your 

- eye span 

- rate of perception 

- eye movement 

- ability to decode the printed words. 

Eye Span 

If you currently read only one word per pause, and you widen your eye span to 

two words per pause, you will read twice as fast. If you widen your eye span to 

three words per pause, you will triple your reading speed. 

To increase your eye span, you need to make better use of your peripheral 

vision. Most of us use our peripheral vision while walking, driving, playing 

sports—in every activity except reading. But peripheral vision is just as useful 

in reading as it is in the rest of our daily lives. 

The chart below illustrates the importance of peripheral vision in reading. 

Start with the first line. Focus on the dot in the center of each line. Without 

moving your eyes from side to side, see if you can recognize all the letters on 

each line. Remember to focus on the dot—not the letters. 

A E 

G Ag H.2ak 

7 B 

0 E Oe oe 

Q 

Pee Se & Gx 

You'll probably be surprised at how many letters your eyes can recognize at 

one time. Exercising your peripheral vision when you read can greatly widen 

your eye span. 
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Rate of Perception 

The more rapid your perception rate—that is, the less time you spend each 
time your eyes pause—the faster you will read. Studies have shown that most 
of us can greatly increase our rate of perception. Reading teachers often use a 
tachistoscope—a device that displays words for a fraction of a second—to 

help their students do this. The Warm-up Letters and Warm-up Words in Speed 
Reader II work on this principle; they speed up your rate of perception and 
increase your eye span at the same time. 

As your perception rate improves, you'll find your ability to concentrate on 
what you’re reading will also improve. 

Eye Movement 

After you have increased your rate of perception and widened your eye span, 
your eyes must be trained to move in wider sweeps from one group of words to 
the next. Without these wide, rapid movements, your wider eye span will be 
wasted. (What use is the ability to recognize three words at a time if your eyes 

stop at every single word?) 

The Eye Movement and Column Reading exercises in Speed Reader II will help 
you retrain your eyes to move rapidly from one group of words to the next. 

25 SELF-STUDY COURSE 



Speed, Comprehension, and Retention 

Has anyone ever told you, ‘‘Fast readers don’t understand as much of what 

they read as slow readers’’? 

This is a popular myth about reading. Not only do fast readers understand as 
much of what they read as slow readers, they often understand much more. 

As you increase your reading speed, your comprehension will probably 
increase. Why is this? Because fast readers read in groups of words instead of 
word-by-word. Words in phrases have more meaning than words in isolation. 
As you read in groups of words, you'll understand what you read more rapidly 
and completely. 

As you continue to increase your speed, your retention will improve along with 
your comprehension. You'll more accurately remember what you read. Because 
good reading habits are less tiring, you'll find that your attention span and 
your powers of concentration will increase. 
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Getting Started 

The following course outline contains a series of eight practice sessions 
designed to improve your reading skills. Although these sessions are self-paced, 
follow these guidelines for best results: 

- Perform all the activities for each session in the order in which they are 
listed. 

- Do no more than one session per day, but do at least two sessions per 
week. 

- Spend no more than twenty to thirty minutes on the computer during 
each session. After thirty minutes, the effectiveness of the exercises 
decreases. 

Immediately after you complete a session, read from a book, magazine, or 
newspaper. Push yourself to read faster. Read in groups of words as you did 
while using Speed Reader IJ. Practice for short periods several times between 
Sessions. 

As you advance through the course, record your progress on each exercise. 
Expect some fluctuation in your scores, rather than a steady increase in speed. 
Your general direction will be toward higher speeds and greater 
comprehension. 

After a few sessions, you may wish to adjust the course outline to emphasize 
areas where more practice is needed. Increase or reduce the time spent on Eye 
Movement, Column Reading, or Paced Reading as necessary. Feel free to repeat 
a reading selection for the extra practice. It may be easier to reach a higher 
speed by repeating a passage. 

Always begin each session with Warm-up Letters, Warm-up Words, or both. 
Always end each session by reading from a book, magazine, or newspaper. 

Have fun! 

ae SULF-STUDY COURSE 



Determining Your Reading Speed 

Begin the Speed Reader I] reading improvement program by measuring your 

present reading speed: 

. Read a Timed Reading exercise as described in the first part of this 

manual. 

- Take the quiz. 

- Record your speed and comprehension level. 

- If you wish, print a report of your score for reference. 

How does your present reading rate compare with those of other readers? Here 

are some average reading rates and comprehension levels: 

Speed — Comprehension 

Adults 250 wpm 50 percent 

— College Students 325 wpm 50 percent 

High School Students 250 wpm 50 percent 

Keep these figures in mind when you set a goal for yourself. If your reading 

rate falls within this average range, you should be able to double or triple your 

rate while maintaining or improving your level of comprehension. 

Note: If you have been diagnosed as having a reading disability or perception 

problem, you should work through these exercises with a reading instructor. 

The instructor may choose to emphasize some exercises over others, or change 

their sequence. | 
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Practice Session 1 

1. Warm-up Letters: 

- Start with two letters, and work up to the top speed before you advance 
to three letters. Remember to focus on the target! 

- Work for about five minutes on this exercise. 

- At the end of the exercise, record your score. 

2. Warm-up Words: 

- Start with two words, and work up to the top speed before you advance to 
three words. 

- Work for about five minutes on this exercise. 

- Record your score. 

4. Column Reading: 

- Read one selection. Begin with a narrow column width. 

- Take the quiz and record your score. 

- Repeat the article if you wish, but skip the quiz. 

4, Eye Movement: 

- Begin with four pauses per line, and advance to three as soon as you are 
able. 

- Read one selection. 

- The default speed for the first selection will be based on your Timed 
Reading score. You may, however, increase or decrease the speed. 

- Answer the questions. 

- If you score 75 percent or higher on the quiz, the default speed for the 
second selection will automatically be increased by 25 wpm (words 
per minute). 

- Record your scores. 

- Repeat this article if you wish. Skip the quiz. 

5. Print out the report of your scores, if you wish. Quit Speed Reader IJ. Read 
from a book, magazine, or newspaper for at least 10 minutes. Push yourself! 
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Practice Session 2 

1. Warm-up Letters: 

. The program will default to the last level you worked on. Go to the top of 

that thermometer before you advance to the next one. 

- Work for five minutes on this exercise. 

- Record your score. 

2. Warm-up Words: 

. The program will default to the last level you worked on. Go to the top of 

that thermometer before you advance to the next one. 

- Work for five minutes on this exercise. 

- Record your score. 

3. Column Reading: 

- Read one selection. 

- Take the quiz and record your score. 

4. Eye Movement: 

. You can warm up for the Eye Movement exercise by rereading a selection 

you read during the last session. This time, read it at a higher speed. 

Skip the quiz. 

- Read two new selections and answer the questions. 

- Record your scores. 

5. Paced Reading: 

- Read one selection. 

. The default speed will be based on your Timed Reading score. You may, 

however, increase or decrease the speed. 

- Answer the questions and record your score. 

6. Print out the report of your scores, if you wish. Quit Speed Reader II. Read 

from a book, magazine, or newspaper for at least ten minutes. Push yourself! 
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Practice Session 3 

1. Warm-up Letters: 

. Start with the default level, and go to the top of that level before you 

advance to the next. 

- Record your score. 

2. Warm-up Words: 

- Start with the default level, and go to the top of that level before you 

advance to the next. 

- Record your score. 

3. Column Reading: 

- Read one selection. Make the column slightly wider than last time. 

- Answer the questions and record your score. 

4. Eye Movement: 

- Read two selections. Follow the same procedure as for Session 2. 

- Answer the questions and record your score. 

5. Paced Reading: 

- Read one passage. 

+ Take the quiz and record your score. 

- Repeat the passage, if you wish, for further practice. This time, skip the 

quiz. 

6. Quit Speed Reader IJ. Read from a book, magazine, or newspaper. Be sure 

to read in groups of words. | 

You're making great progress. Keep pushing yourself! 
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Practice Session 4 

1. Warm-up Letters: 

- Work for five minutes on this exercise. 

- Follow the same procedure as for Session 3. 

2. Warm-up Words: 

- Work for five minutes on this exercise. 

- Follow the same procedure as for Session 3. 

3. Column Reading: 

- Read one selection. 

- Answer the questions and record your score. 

4. Eye Movement: 

- Read two selections and answer the questions. 

- Record your scores. 

5. Paced Reading: 

- Read one selection. 

- Answer the questions and record your score. 

6. Timed Reading: 

- Read one passage. Push yourself. 

- Take the quiz and record your score. 

- If your Timed Reading rate fell below your Paced Reading rate, repeat 
the Timed Reading. Try to go faster. You can do it! : 

7. Quit Speed Reader II, and read for ten or fifteen minutes. Remember, it 
takes practice to become good at anything! 
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Practice Session 5. 

1. Warm-up Letters: 

- Work for five minutes on this exercise. 

- Follow the same procedure as before. 

2. Warm-up Words: 

- Work for five minutes on this exercise. 

- Follow the same procedure as before. 

3. Column Reading: 

- Read one selection 

- Take the quiz and record your score. 

4. Eye Movement: 

- Read two selections. 

- Answer the questions and record your scores. 

5. Paced Reading: 

- Read two selections. 

- Answer the questions and record your scores. 

6. Quit Speed Reader II, and read. Push yourself! 

a 
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Practice Session 6 

1. Warm-up Letters: 

- Work for five minutes on this exercise. 

2. Warm-up Words: 

- Work for five minutes on this exercise. 

3. Eye Movement: 

- Read two passages. 

- Answer the questions and record your scores. 

4, Paced Reading: 

- Read two passages. 

- Answer the questions. Record your scores. 

5. Quit Speed Reader II, and read from a book for ten to fifteen minutes. Read 

for ideas and important facts. Push yourself! The harder you try, the more 

you'll improve. 
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Practice Session 7 

1. Warm-up Letters: 

- Work for five minutes on this exercise. 

2. Warm-up Words: 

- Work for five minutes on this exercise. 

3. Eye Movement: 

- Read two selections. 

- Answer the questions and record your scores. 

4, Paced Reading: 

- Read two passages. 

- Take the quizzes and record your scores. 

5. Timed Reading: 

- Read one passage. 

- Read at your fastest rate. 

- Take the quiz and record your score. 

6. Quit Speed Reader IJ, and read from a book for ten to fifteen minutes. Read 
in phrases, and push yourself! Don’t allow yourself to go back and reread. 

35 | SELF-STUDY COURSE 



Practice Session 8 

1. Warm-up Letters: 

- Work for five minutes on this exercise. 

. Remember how tough these Warm-up Letters were when you first € 

started? You’re making progress! 

2. Warm-up Words: 

- Work for five minutes on this exercise. 

3. Eye Movement: 

- Read two selections. Take the quizzes. Record your scores. 

4, Paced Reading: 

- Read two passages. 

- Answer the questions and record your scores. 

5. Timed Reading: 

- Read a passage at your fastest rate. 

- Answer the questions. 

- Record your score. 

- Compare this score with your beginning score. 

6. Print out a graph showing your marvelous progress! 
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Congratulations! You’ve made a major improvement in your reading skills. 
These enhanced skills will help you every day for the rest of your life. 

As a faster reader, you'll have far more flexibility. You'll want to read some 
materials at your highest speed. You’ll want to read other materials at a 

> slower pace, either because of their difficulty or because they’re extremely 
interesting. You may not always want or need to read at your fastest rate—but 
now you have a choice. 

To maintain and improve your speed and comprehension, you must continue 
to read. Having mastered the basic techniques, the more you read, the better 
you'll become. 

Return to Speed Reader II at least once every 3 or 4 weeks to keep your 
reading skills at their highest. level. 
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ADDING NEW READING SELECTIONS 

You may obtain additional reading selections for use with Speed Reader II in 
either of two ways: 

1. Order a Speed Reader II data disk from Davidson and Associates, Inc. Each 
disk contains twenty Eye Movement/Column Reading selections and fifteen 
Paced Reading/Timed Reading selections, with comprehension questions. They 
are available for the following levels: 

Disk A 4th, 5th, and 6th grades 
Disk B 7th, 8th, and 9th grades 

Disk C 10th, 11th, and 12th grades 

Disk D College students and adults 

Complete instructions for using the additional data disks with Speed Reader II 
are included in each package. 

2. Create your own selections and write appropriate questions using the Speed 
Reader I] Editor. Save them on a separate disk. 
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USING THE EDITOR 

The Speed Reader I/ Editor allows you to create and use additional reading 
selections. These selections should be saved on a separate disk. 

To use the Editor: 

- Quit Speed Reader I] and return to the Macintosh Finder screen. 

_ + Double-click the Editor icon. 

Here are a few general guidelines for using the Editor: 

- Start typing at the blinking bar, which indicates the insertion point. 

- Press the backspace key to erase characters to the left of the blinking bar. 

- To move the blinking bar, point with the mouse and click once. 

- Be sure to return the blinking bar to the end of your typed text when you 
are ready to resume typing. 

To select part of your text: 

- Click and hold down the mouse button just before the first character. 

- Drag to just past the last character. 

- Release the mouse button; the selected text will be highlighted. 

To move, erase, or copy selected text, pull down the Edit menu: 

- Cut erases highlighted text and saves it for copying. 

- Copy saves a copy of highlighted text for duplication. Unlike Cut, Copy 
leaves the original as it was. 

- Paste copies text that has been Cut or Copied into your document at the 
insertion point. 

- Clear permanently erases the selected text. 

- Select All selects your entire text. 

a 
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Entering Text 

Type in your own reading selection. A good length for Column Reading and 
Eye Movement passages is about 200 words. Paced Reading and Timed Reading 
selections may be up to 600 words. 

Entering Questions 

After you have entered your complete text, create questions to test the reader's 

comprehension. 

You may enter from one to eight questions. We recommend using four 

questions with Column Reading and Eye Movement selections, and eight 

questions with Paced Reading and Timed Reading selections. 

To enter questions: 

- Pull down the Special menu. 

- Select Questions. 

- Type the question in the box at the top of the window. 

- Use the mouse to move the insertion point (or press the Tab key) and 

type the first answer choice opposite the letter A. 

- Type additional choices opposite B, C, and D. 

- Click the letter of the correct answer. 

- Click Next to create the next question. 

- Click Previous to review earlier questions. 

- If you decide not to use a question, click Delete to erase it. 

- When you’ve finished entering your questions, click Cancel. 

To check whether you have entered the questions and answers correctly: 

- Pull down the Special menu. 

- Select Review. 

- Take the quiz as you would while using Speed Reader 11. 
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Saving and Classifying the Reading Selection 

To find the approximate grade level of the selection you have entered: 

4 - Pull down the Special menu. 

4 - Select Analyze. 

- The program will count the number of words, syllables, and sentences 

in the selection and display the approximate reading level. 

‘The Analyze option ok only at the passage—not at the questions. The 
ding level is approximate, based on the number of words and syllables. 

0 ther factors that affect reading level—such as vocabulary, sentence structure, 

and complexity of ideas—are not measured. 

Bivembes that most books, magazines, and newspapers are written at a 7th or 
“sth grade level. 

To save your reading selection: 

q - Pull down the File menu. 

- Select Save AS... 

- Type a file name in the box. 

- Click Column Reading/Eye Movement if the passage is to be used with 
those exercises. 

- Click Paced Reading/Timed Reading if the passage is to be used with 
those exercises. 

Click Save. 

Remember, save your files on a separate disk. 

ry 
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When your reading selection has been properly entered, the student will be, 
able to use it with the appropriate parts of the program. Speed Reader II will 
automatically calculate the reading rate, administer and score the quiz, and 
record the student’s scores. 

To print the selection and questions: 

- Make sure your printer is on-line and has paper. 

- Pull down the File menu. 

- Select Page Setup. 

- Click the buttons to specify page size and orientation. 

- Click OK. 

- Pull down the File menu again. 

- Select Print. 

- Click the buttons to specify quality, page range, copies, and paper feed. 

- Click OK to start printing. 

To leave the Editor and return to Speed Reader II: 

- Pull down the File menu. 

- Select Quit. 

- From the Macintosh Finder screen, double-click the Speed Reader II 
icon or a student file icon. | 
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APPENDIX 

Menus 

Default Speeds, Levels, and Ranges 

Suggestions for Managing Your Files 



SPEED READER IT MENUS 

New. . 

Creates a new student file and starts a 

session. 

Open... 

Opens an existing student file and starts 
a new session. 

Close 

Closes the current student file. 

Save 

Saves the current student file to disk. . 

46 MENUS 

Page Set-up... 

Lets you specify page size and 
orientation (vertical or broadside) of 

printed reports and graphs. 

Print... 

Lets you specify quality (draft or 
presentation), page range, number of 
copies, and paper feed (single sheet or 
continuous) of printed reports and 
graphs, before printing. 

Report 

Displays a record of each session, 
including the date and time, your level 
and scores for warm-up exercises, and 
your speed and comprehension for 
other exercises. 

e 
—— 

Quit (or Command-Q) 

Leaves Speed Reader II, saves the 
record of your exercises to a student 
file, and returns to the Macintosh 
Finder screen. 



Exercise 

“Sound On 

Start 

Opens the currently selected Speed 
Reader II exercise (the same as double- 

clicking the icon). 

Stop 

Ends the currently selected exercise (the 
same as clicking the close box). 

Graph (or Command-G) 

Displays a graph of your progress in the 
current Speed Reader II exercise, 
indicating the level (for warm-up 
exercises) or speed and comprehension 
(for reading exercises). 

Sound On 

If clicked when sound is on, turns off 

sound. If clicked when sound is off, 

turns on sound. (Sound level is 
regulated from Control Panel menu 
reached by clicking apple icon in upper 
left corner of screen. ) 

47 MENUS 

Getting Started 

Directions 

Theory 

Getting Started 

Gives basic directions for using Speed 
Reader II for the first time. 

Directions 

Gives step-by-step directions for 
completing the selected Speed Reader 
/T exercise. 

Theory 

Outlines what the selected Speed 
Reader II exercise will do to improve 
your reading speed and comprehension. 



EDITOR MENUS 

New 

Open... 

Close 

Save 

Save As... 

Revert to Saved 

Page Setup... 

New... 

Creates a new file for a reading 
selection. The selection you enter will 

be stored in this file. 

Open ... . 

Opens an existing file for editing or 
review. 

Close 

Closes the current reading selection file. 

Save 

Saves the current reading selection file 
to disk. 
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Save AS... 

Saves the current reading selection to — 
disk under a new file name. 

Revert to Saved 

Throws away the current reading 
selection and brings the last version 
saved under that name into the Editor. 
Especially useful if you have 
accidentally deleted part of your text or 
made extensive, unsatisfactory changes. 

Page Set-up... 

Lets you specify page size and 
orientation (vertical or broadside) of 
printed reading selections. 

Prints 

Lets you specify quality (draft or 
presentation), page range, number of 
copies, and paper feed (single sheet or 
continuous) of printed reading 
selections. 

Quit (or Command-Q) 

Leaves the Editor and returns to the 

Macintosh Finder screen. 
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Select All SA 

Cut (or Command-x) 

Erases selected text and saves it for 

copying elsewhere in the document. 

Copy (or Command-H) 

Saves a copy of selected text in memory 
for copying elsewhere in the document; 
leaves the original selected text 
unchanged. . 

Paste (or Command-C) 

Copies text that has been cut or copied 
into the document at the insertion 
point. 

Clear (or Command-V) 

Erases the selected text without making 
a copy of it. 

Select All (or Command-A) 

Selects (highlights) the entire 
document. 
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Special 

Analyze 

Questions 

Review 

Analyze 

Counts the words and syllables in a 
reading selection, then gives the 
approximate grade level of the 
selection. 

Questions 

Displays the format in which your 
questions for the reading selections may 

be entered and correct answers 
specified. 

Review 

Administers and scores the quiz so that 
you can check it for accuracy. 



DEFAULT SPEEDS, LEVELS, AND RANGES 

Warm-up Exercises 

Speed Length of Display 
(seconds ) 

0) 2.0 
l 1.3 
2 1.0 
e 0.66 
4 0.5 
p 0.41 

6 0.33 
, 0.25 
8 0.20 

9 0.16 
10 0.15 
i 0.13 

I 0.11 

13 0.08 

14 0.06 

15 0.05 
16 0.03 

Eye Movement/Column Reading 

Comprehension Level 
0-25 percent 

50 percent 
75-100 percent 

Paced Reading/Timed Reading 

Comprehension Level 
0-37 percent 

50-62 percent 
75-100 percent 

50 DEFAULTS 

Default Change in Speed 
reduce speed 50 wpm 
no change 
increase speed 25 wpm 

Default Change in Speed e_ 
reduce speed 50 wpm 
no change 
increase speed 25 wpm 



SUGGESTIONS FOR MANAGING YOUR FILES 

There is room on your Speed Reader II system disk for four or five student 
files. If you wish to keep records for more students, you may do so by 

- saving them onto a separate disk, or 

- making more room on the system disk by removing the Editor and 
saving it on a separate data disk. It would be convenient to have the 
editor on the same disk with any new reading selections that you 
might add. 

% 
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&o tware Review 
By: Jim Wellman 

Co- Sysop, APPLESIG, ID SIGO7S, on the SOURCE(tm), (c) 1989 

MACHINE 

Tle, Ic, Ic+, and IIGS with 128K and 80 
column card (Also available for MS-DOS 256K, 

VGA, MCGA, CGA and Hercules compatible. 

PRODUCED BY 

Davidson & Associates, Inc. 

3135 Kashiwa Street — 

Torrance, CA 90505 

EXTRAS | 

Printer required for Certificate of Excellence | 

and tests _ | — = 

PRICE: $49.95 

u 

Well Davidson & Associates have out done them- 
selves this time with their new addition: Math 
Blaster: Mystery. One of the first things that 
stands out in their excellent documentation is their 

“FIVE-YEAR WARRANTY” on their disk! Now this 

alone is a step in the correct direction to completely 
support their customers. 

Davidson & Associates have very simple system 
requirements: 128K and 80 column card. The color 
monitor, mouse, and printer are optional equipment. 
After playing this game for a while I was convinced 
that this is really great: 
have lived up to their motto once again: “Teaching 
Tools from Teachers~ 

I turned over the computer to my 9 and 11 year old 
with amazing results! First, I want you to know that 
they will fight over playing the Nintendo but when 
they were sitting down with Math Blaster: Mys- 

tery they were helping each other solve the puzzles! 
Nintendo eat your heart out!!!!!!! 

“Math fina M —— 

called activities: 

Davidson & Associates — 

is divided into four areas 

Activity 1: Follow the Steps which are word based 
problems teaching students to quickly solve the 

| problems. Follow the Steps has 25 problems | in each 
- of four levels. 

ethty 2: Weigh the Evidence is similar to the — 
| problem of moving the smaller rings to the top of the _ 

_ tower of the stack thus creating a pyramid. In Weigh 
| the Evidence students are to move weights from one 

scale to the next according to the “target” weight to 
achieve. There are 4 levels of difficulty here too. 

Activity 3: Decipher the Code is similar to Master- 
mind where you have to find the correct equation 

| instead of the colored pegs. This too contains 4 levels | 
- to master. 

Math Blaster: Mystery utilizes Pull-Down menus 
and will print out tests, quizzes, and other informa- 
tion on 41 different printers! I don’t see you having 
problems finding your printer or interface card in 
Appendix B where the setup information can be 
found! Also, should you havea problem they are only 
an “800” call away! 

As a final note, I had to chase my two sons off the © 

computer so I could write this review ... they are 
| standing behind me now waiting for the second I 
save so they can return to Math Blaster: Mystery. | 

Math Blaster: Mystery spans both sides sf two 
5.25 inch disks and is written for ages 10 and up and™ 
grades 5 - 12. I feel that you will get your monies 
worth from this game for many months to come! 

Other products available from Davidson & Associ- 
ates include: Math Blaster, Math Blaster Plus, 
Math and Me, Read ‘N Roll, Reading and Me, 
Grammar Gremlins, Spell It, Homeworker, 

- Word Attack, Word Attack Plus, Word Attack 

| Plus Spanish, Word Attack Plus French, Speed 
Reader II, Alge-Blaster, and Classmate! 

| guessing game where students guess the number. 





Speed Reader II has a 5-YEAR warranty! 

To receive important product update information and to register this product, 
please complete this card and return it to us today. 
Name 

Street Address 

City State __—s_—s Zip 

Telephone Number (__) 

Your Version [JApple DIIBM [164/128 C1 Mac 
Disk Size J 5.25" 13s" 
Purchased From | 
Address Date 

In what type of store was your program purchased? 

(J Hardware & software store [[] Discount store CJ Mail order-advertisement 
(-] Software only store [IBook store [] Other 
(] Department store C)Mail order-catalog 

What MOST influenced your purchase? | | 

[J Salesperson CJ Friend [] Magazine ad [JYourchild [J Other 
[ Teacher/School CJ Newspaper [] Gift — [] Review 
Back-up Copy | 
[) Send a back-up copy of Speed Reader II. A check for $10.00 to Davidson & Associates, 

Inc. is enclosed. California residents please add applicable sales tax. 

[JI do not wish to purchase a back-up at this time. fabs 
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‘SOFTWARE GIVEAWAY! 

We Need An Expert Opinion— 

YOURS 

Now that you've had an opportunity to work with a Davidson software 
program, we want to know what you think. By filling out the questionnaire 
and sending it to us, you become eligible to enter our monthly drawing for 
$100 worth of FREE Davidson software. 

We will also add your name to our mailing list allowing us to keep you 
updated on our new software products, videos, workbooks, and much more. 



NAME PROFESSION 

SCHOOL/ORGANIZATION (if appropriate) : 

ADDRESS 

CITY STATE | ZIP 

PHONE NUMBERS: WORK HOME 

——— 

The Davidson product you are telling us about __ 

What type of computer do you have? 

Do you own any other Davidson programs? [1 Yes CL) No 

If yes, which ones? nes. 

Where is the program primarily used? [JHome [Classroom ULab U1] Other__ 

If in the home, how many children use it? _____»—~3=- What ages? 

If in the classroom, what grade(s) or special classes use the program? 

Number of students who use the program? Number of computers? 

How often is the program used ? LJEachday LJOncea week L1Once a month [] Other______ 

How easy is the software to use? LJ Very easy L) Easy L Fairly difficult LJ Very difficult 

What do you like best about the software? 

What features of the software do you use most often(i.e. game, certificate, etc.)? 

What features would you like to see added or changed in this program to improve it? 

How would you rate the software manual? CL] Excellent L) Very good OH Fair UO) Poor 

Please describe any errors or inconsistencies in the manual you may have encountered? 
(Page numbers would be helpful.) 

Have you ever called Davidson Customer Service for help in using this program? L] Yes LJ No 

If yes, how would you rate the service you received? LJ Excellent 1 Very good U1 Fair LU Poor 

Comments 

How would you rate this software overall? LJ Excellent 1] Very good L/Fair LPoor 

Based on your experience with this software, how likely would you be to purchase another 

Davidson program? ([L1Very likely | [LJSomewhat likely 

What kind of educational software products would you like to see Davidson develop? 

YOUR AGE(Circle) Under18 19-24 25-30 31-36 37-42 4348 49-54 55+ 

After completing this questionnaire, fold card in half, seal and mail. 



Name 

Address 

City 

State Zig 

Davidson & Associates, Inc. 

3135 Kashiwa Street 

Torrance, CA 90505 

ATTN: PRODUCT PLANNING 

LETTTER 
POSTAGE 
REQUIRED 



Special Offer 

SAVE 
$5.00 
off the regular 
retail price 
Details On Back 

Davidson. 
, Educational Videos 

That Make Learning Fun! 



Imagine a way for your child to 
grasp math concepts through humor 
and music instead of chalkboards 
and pointers. A way to see math 
facts applied to everyday situations 
and understand their importance. 
A method to build a lasting more 
positive attitude towards math. 
These are the benefits that David- 
son’s dynamic new educational 
videos bring to your children. 

Each video starts with a genuinely 
funny adventure story that 
includes a cast of endearing live 
action characters (showcasing the 
talents of renowned L.A. comedy 
troupe, the “Groundlings”). As 
each story unfolds, your child will 
be drawn into amusing situations 
that call for the use of addition, 
subtraction, multiplication or divi- 
sion to find solutions. 

Designed by teachers to 
motivate children to 

learn, Davidson videos 
teach your child the 

importance of under- 
standing math funda- 

mentals in order 
to succeed. 

With Davidson Ky Winning Vid COS. 
What makes Davidson videos so 
unique is that the math problems 
are presented as a natural part of 
everyday life, not just as confusing 
combinations of numbers. 

Each video presents a variety of 
important math skills that your 
child needs to be successful: 
e Verbalizing problems 
e Using clue words to determine 
when to add, subtract, multiply 
or divide 

e Working with units of measure- 
ment and time 

These award-winning Davidson 
videos feature live action, humor 
and music to create entertaining 
stories that your child will ask to 
watch again and again. Davidson 
videos make learning new skills 
fun and exciting...and that’s 
a winning combination! 



In Search of 
the Missing 
Numbers 
Addition & Subtraction 

Ages 6-9 

“Winner 
New York 

International 
Film & TV 
Festival” 

ay] ason :. 

ee From 
queatay 

Teachers 

react 

Join Brad, Melissa and the Blasternaut in 
their search for the bumbling number- 
snatching computer bugs. 

ypsiGolo? 

Rock 
Countdown 
Multiplication & Division 
Ages 9-12 

Davidsot : . Kyo! 

Teachings fools! i (eye ME EC) 

Amna and Louis, winners of the math trivia 
contest, begin their adventures at the taping 
of Math Rock Countdown. 

Children will delight in following 
Brad and Melissa into the fantasyland 
of Blasteria as they search for missing 
numbers. Along the way, our heroes 
befriend Papa Roni, The Processor, 
Memory and Cross D. Bridger. These 
colorful characters use addition and 
subtraction to help solve the mystery 
of the missing numbers AND save 
Blasteria from the evil computer bugs, 
Fallover Crumbwell and Crawley. 
Math was never this much fun! 

Cross D. Bridger learns that knowing your 
math skills makes life a whole lot easier, and 
a lot more fun. 

Move over MTV! Anna and Louis, math 
trivia contest winners, attend the tap- 
ing of “Math Rock Countdown,’ Amer- 
ica’s top-rated new music show with 
zany producer, Sterling Pinchpenny. 
Rap with The Products as they master 
multiplication. Sway with The Siblings 
in division blues. Sing along with 
Treva Sue and The Bleaters as they use 
math facts to tell their country rock 
story. Join host K.C. Greasum and the 
entire cast in this zany mathematical 
and musical countdown. 

plication and division rules in a fun-filled 
musical countdown. 



Award-Winning Educational Videos So 
Entertaining, Children Are Eager To Learn. 
Objective: In Search of the Missing Numbers and Math Rock Countdown 
were designed by teachers to motivate children to learn by demonstrating 
how math is used to solve problems in everyday situations. 

In Search of the Missing Numbers Math Rock Countdown 

Level: Ages 6-9 (Grades 1 through 3) Level: Ages 9-12 (Grades 4 through 6) 

Running Time: 60 minutes (two Running Time: 50 minutes (two 
30-minute segments separated by 25-minute segments separated by 
an intermission) an intermission) 

Suggested Retail Price: $19.95 Suggested Retail Price: $19.95 
Format: VHS/Full Color | Format: VHS/Full Color 

ORDER TODAY! REGULARLY $19.95 
NOW ONLY $14.95 EACH! 
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Customer Service 

Five-Year Warranty on All Disks: 

If for any reason your disk becomes damaged, Davidson will replace it FREE. Simply 
mail us the damaged DISK ONLY with a note requesting a replacement. 

FREE Disk Swap: | 

To exchange your 5 1/4" disk for a 3 1/2" or vice versa, send us your DISK ONLY 
with a note requesting a swap. 

Back-Up Disks: 

To receive a back-up of any Davidson software program, send us your registration 
card with a check or money order for $10. 

Additional Information: 
To receive additional information on any Davidson program, call or write us for a 
FREE fact sheet detailing the benefits and features of each individual program. 

Upgrade Offers: 

If you have Math Blaster™, Word Attack™, Alge-Blaster™ or Spell I (™, y you can 
upgrade to the “PLUS” versions of these award-winning programs, (see individual 
program pages). Just send us your existing Math Blaster, Word Attack, Alge-Blaster or 
Spell It program DISK ONLY with a check or money order for $19.95 each. Davidson 
will send you the program upgrade kit including the new disk and manual. 

Davidson & Associates, Inc. 

is a principal sponsor of 
Customer Computer Learning Month 

eos PRINCIPAL 
Hotline: SPONSOR 

COMPUTER 
LEARNING 

Call us toll-free for technical 

support or for the name of your 
Authorized Davidson Dealer. 

(800)556-6141 

(213)534-2250 (CA Only) 

7:30 a.m.-5:00 p.m. PST 

Davidson & Associates, Inc. 

3135 Kashiwa Street 

Torrance, CA 90505 

© 1989 Davidson & Associates, Inc. 

Apple, IBM, Tandy, Commodore, & Atari are 
trademarks of those respective companies. 
Macintosh is a trademark of Apple Computer, Inc. 

OCTOBER 

WD Davidson. 
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‘ Mathematics 

_ Software 

Math Blaster Plus: 

Best-selling Math Blaster Plus 
presents colorful graphics and 
animation to motivate your 
children to build solid math 
skills and develop confidence. 

Program Contents: Math Blaster Plus 

covers all fundamental math skills in 

addition, subtraction, multiplication, 

division, fractions, decimals, and percents. 

Five Learning Activities: 
eCountdown — e Orbit 
e Ignition e Blasternaut Game 
° Lift-Off a 

Apple lIGS and Atari ST 

OT sions available 

Easy-To-Use Editor and Test Maker: 

These unique features allow users to 
customize the program with special math 
equations. 

Printed Certificate of Excellence: To award out- 
standing scores, Math Blaster Plus includes a feature that 
will print out a Certificate of Excellence with graphics. 

“The new and enhanced 

version of the Davidson & 
Associates classic Math 

Additional Features: 

e Score-keeping 
e Postive reinforcement 

e Optional sound effects 
e Animation and color 

e Re-take option for missed 
items 

e Print capability 
e Easy-to-use pull-down 
menus and icons 

e Double high-resolution 
graphics 

FOR AN AUTHORIZED DEALER 

CALL TOLL FREE 
800 556-6141 
213 534-2250 CA ONLY 

All Davidson MS/DOS 

programs are hard disk 
installable. 

Blaster is even better than 

the original. New graphics 
and pull-down menus give 

Math Blaster Plus a classy 

new look... and its [other] 

new features make it a 
valuable teaching tool.” 

System 

Requirements: 

Apple IIGS, IIc+, Ic, le 

(128K & extended 80- 

column card) 

IBM PC & PS/2 

Tandy 1000 series 

Major compatibles 

Atari ST (512K) 

Apple II+; C64/128; 
Macintosh; Atari 800XL, 

65E, 130XE; IBM PC Jr. 

owners! Ask for Math 

Blaster. 

a. 

A+ Magazine 

Level: 
Ages 6 through 12 

5 1/4" to 3 1/2" disk exchange 
available FREE 

Supplement your software 
with workbooks. See page 19. 

Suggested Retail 
Price: $49.95 

$39.95 (Atari ST) 

Math Blaster Owners! 
To upgrade to Math Blaster 

Plus, send us your Math 

Blaster disk only and $19.95. 

DD Davidson. 



Math Blaster Mystery” 
DADA AAAADAAAAAADADAAAAAAEAAAAAAAADAAADADAAAAAAEAAAA AL 

Math Blaster Mystery teaches 
strategies for solving math 
word problems and develops 
critical thinking skills. 

Program Contents: The “Study the 
Steps” activity presents a highly effective 
step-by-step approach for solving word 
problems. The “Weigh the Evidence,” 
“Decipher the Code,” and “Search for 

Clues” activities build critical thinking 
skills as students apply inductive and 
deductive reasoning. Math concepts 
covered include: whole numbers; fractions, 

decimals, and percents; positive and 

negative numbers; interest and principle; 
and pre-algebraic concepts. 

Easy-To-Use Editor: Customize the program 
with your own word problems. 

Helpful “Hint” Screens: Instructions, formulas, 

definitions, and hint screens help students develop 
problem-solving strategies. 

Additional Features: 

¢ High-resolution graphics 
© Certificate of Excellence 

° Positive reinforcement 

¢ Pop-up calculator 
° Record-keeping 
¢ Animation & sound 

System 

Requirements: 

Apple IIGS, IIc+, 
IIc, le (128K & 

extended 80- 

column card) 

IBM PC & PS/2 

FOR AN AUTHORIZED DEALER 

CALL TOLL FREE 

Tandy 1000 series 
Major compatibles 

. Problem-Solving 

» Software 

» ages 10 eup 7 

« Graces B- 

“I want you to know that 
[my 9- and 11- year-olds] 
will fight over playing 
Nintendo. But when they — 
were sitting down with 
Math Blaster Mystery, 

they were helping each 
other solve the puzzles! 
Nintendo eat your heart 
out!!!” 

Jim Wellman 

Reviewer 

The Source 

Level: 
Ages 10 through adult 

5 1/4” to3 1/2” disk 
exchange available FREE — 

Suggested Retail 
Price: $49.95 

All Davidson MS/DOS 
800 556-6141 
213 834-2250 CA ONLY installable. 

programs are hard disk 
ae Davidson. 
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Mathematics 

Alge-Blaster Plus \ 

Alge-Blaster Plus covers 1* 
and 2°“ semester algebra in 
one program and includes a 
challenging graphing game! 
Program Contents: The program offers a 
step-by-step approach to algebra through 
practice in positive/negative numbers, order 
of operations, monomials & polynomials, “’ @, ° Saaeerr 
equations, factoring, systems of equations, 4 ‘ + Grades 7-1? 
algebraic fractions, radical expressions, and ae 
quadratic equations. Alge-Blaster Plus con- 
tains over 500 algebraic equations and an 
infinite number of computer-generated 
problems for graphing and translating word — 
problems. Perfect for students of all ages. 

Easy-to-Use Editor: The editor makes it 

easy to add your own list of problems to solve. 

Instructional “Help” Feature Option: 

Alge-Blaster Plus contains an optional help feature, 
on-screen instructions, and a glossary. 

“Alge-Blaster Plus 
helped me understand 
and review basic algebra 
by using a step-by-step 
method of teaching, and 

Additional Features: the game is a fun way to 

° Review option e Record-keeping understand graphing!” 
° Certificate of Excellence °® Animation & sound 

¢ High-resolution graphics ¢ Print capability Lori Lacy 
High School Student 

Exeter, N.H. 

File Activity Subject L 

- : System | Level: 
: i Requirements: = Ages 12 through adult 
a : Apple IGS, Ict+, IIc, 51/4" to3 1/2" disk 
# =; Ile (128K & extended exchange available FREE 

ls : 80-column card) © Suggested Retail 
: : IBM PC & PS/2 Price: $49.95 

Tandy 1000 series Alge-Blaster Owners! 
Major compatibles ¢ To upgrade to Alge-Blaster 

Apple II+; C64/128; IBM Plus, send us your Alge- 

Blaster disk only and $19.95. 

PC Jr. owners! Ask for e Extend the life of your FOR AN AUTHORIZED DEALER 
Alge-Blaster. software with additional data 

CALL TOLL FREE oS disks. See page 20. 
All Davidson MS/DOS : 

800 556-6 14 | programs are hard disk 

213 834-2250 CA ONLY justallable. ee Davidson. 



Word Attack Plus 
DADA DAA DAA AAA ADA ADD AA DADA AAAAAAAAA DADA AAA AAA AAA DADA AAA AAA AAD D&D i 

Word Attack Plus teaches 

new words and definitions 

as students build vocabulary 
skills essential to reading 
and writing. 
Five Learning Activities: 

¢ Word Display 
¢ Multiple Choice 
e Sentence Completion 
¢ Word Match 
e Word Attack Game 

Printed Certificate of Excellence: To 

award outstanding scores, Word Attack 

Plus includes an option to print out a 
Certificate of Excellence with graphics. 

Test Maker: Teachers have the option to 
print sentence completion tests for their students. 

Flash Card Maker: Users can create flashcards 
from original or custom data. Then they can print 
the flashcards for additional study. 

Additional Features: 
¢ Record-keeping 
e Easy-to-use editor including 
foreign language fonts for Spanish, 
French, and German 

¢ Positive reinforcement 

e Print capability 

e Ae ade- 

bulary words 

e 700 your 
Over 

€ 
ra ¥ aammin

g acl 

te chive 
i ung 

¢ yilies 

Five if 

stylé y scapula
ry Due 

ee wor tO add 
vey & 

i 
yah y 

¢ Optional sound effects 
e Animation and color 

e Easy-to-use pull-down menus 
e Double high-resolution graphics 

System 

Requirements: 

Apple IIGS, Ic+, IIc, 
Ile (28K & extended 

80-column card) 

IBM PC & PS/2 

Tandy 1000 series 

Major compatibles 

Apple II+; C64/128; 
FOR AW AUTHORIZED DEALER 5 a 

Macintosh; Atari 
CALL TOLL FREE 

All Davidson MS/DOS = 800XL, 65E, 130XE; 
800 556-6141 programs are hard disk {BM PC Jr. owners! 

216 834-2250 CAONLY installable. Ask for Word Attack 

Level: 

Ages 10 through adult 

5 1/4" to 3 1/2" disk 
exchange available FREE 

Extend the age level and 
life of your software with 
data disks. See page 20. 

Supplement your 
software with workbooks. 
See page 19. 

Suggested Retail 
Price: $49.95 

BD Davidson. 



Word Attack Plus French’ 
a a oe aD 

Word Attack Plus French builds 
beginning French vocabulary 
for travelers and French 
students. va 
Five Learning Activities: 

¢ Word Display 
¢ Multiple Choice 
¢ Sentence Completion 
¢ Word Match 
¢ Word Attack French Game puilding program 

g activities 7 S Vocabulary : 
st arnt .__.. interactive learn ve wterae @ Fly rocauu 

Printed Certificate of Excellence: To «over 950 French vOCamnST 
lary word 

ace editor tO 
e Easy-to-use & pe award outstanding scores, Word Attack Plus 

French prints a Certificate of Excellence. 

Flash Card Maker: Users can create and © 
print flashcards for additional study. 

eis “The opportunity to 
ina Dae | build French vocabulary 
© Animation and color ¢ Optional sound Sige 

Ee - skills by using five 
e Positive reinforcement e Print capability ‘ ; 

; unique and fun ap- 
¢ High-resolution graphics ® Record-keeping ad cheat: 
ir: | dich iada proaches should increase 
ar ed io ee aaa the motivation of many 

¢ Foreign language font own French words 
Junior and Senior High 
students of French all 
across the nation.” 

with special characters 

James E. Becker 

The French Review 

File Activity Level Words’ Font 

ee eae System Level: 
Requirements: Ages 10 through 

: Apple IIGS, IIc+, adult 

L’armoire est fermée. Ge 51/4” to 3 1/2” disk 
extended 80- exchange available FREE 
column card) : 
IBM PC & PS/2 Suggested Retail 

Space for 
Tandy 1000 series  P¥ice: $49.95 
Major compatibles 

FOR AN AUTHORIZED DEALER 

CALL TOLL FREE Mae eins 
| avidson 

800 556-6141 programs are hard disk Po . 
213 834-2250 CA ONLY installable. Davidson. 



Word Attack Plus Spanish" 
A i kk A 

Whether you're travelling to 
Spain or just beginning a 
Spanish class in school, Word 
Attack Plus Spanish is an easy- 
to-use vocabulary-building 
program. 
Five Learning Activities: 

e Word Display 
e Multiple Choice 
e Sentence Completion “ae 

° Word Match | + sesh at 
e Word Attack Spanish Game 0 Spar ee own wore 

Printed Certificate of Excellence: ) 
To award outstanding scores, Word Attack Plus 
Spanish prints a Certificate of Excellence. | 

Flash Card Maker: Users can create and 

print flashcards for additional study. _ “Word seca Plus 
ex Spanish features an 

vee pean dan pesiehhs q arcade-style game that 
@ @ ° : Sar and color ptional soun puts some fun into 

ositive reinforcement e Print capability vocabulary instruc- 

e High-resolution graphics ¢ Record keeping Hon” 
e Easy-to-use menus e Editor to add your 
e Foreign language font — own Spanish words Curriculum Product News 

with special characters 

File Activity Level1 Level2 Words 

an pee | iat Requirements: Ages 10 through 
Apple IIGS, Hct, adult 

repetir preguntar _repartir IIc, Ile (128K & 5 1/4" to 3 1/2" disk 
borrar preparar _dibujar extended 80- 

ne es column care ) p IBM PC & PS/2 Suggested Retail 

Tandy 1000 series Price: $49.95 
Major compatibles 

exchange available FREE — 

FOR AN AUTHORIZED DEALER 

Cee All Davidson MS/DOS avidson 

800 556-6141 programs are hard disk ° 

213 5354-2250 CA ONLY installable. | Davidson : 



Math and Me - 
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Math and Me develops a life 
long love of math as animated 
monkeys help your child build 
early math skills. 

Program Contents: Math and Me 

includes twelve captivating learning 
games—three in each of four subject areas: 

e Numbers 
e Beginning addition 

e Shapes 
e Patterns 

The material is presented sequentially, so 
the program grows with the child. 

Early Learner Interface: The new 

Davidson Early Learner Interface provides 
easy access to activities and mobility within 
the program. Children can use either the 

mouse or the keyboard to select activities 

and answers. 

Printed Graphic Certificate: When children complete 
an activity, they are rewarded with a graphic certificate 
that includes their name and a picture of the Math and Me 
monkey characters for coloring. 

Additional Features: 
e Positive reinforcement e Animation 

Early Learning 

Software 

Now I'm Talking 
on the IIGS! 

“Teachers, parents, and 

students find Math 

and Me effortless to 

run, colorful, and cap- 

tivating. Math and 

Me is an excellent first 
math program for the 

3-to-6-year-old in your 

e Optional sound effects e Double high-resolution graphics life.” 

triangle 

FOR AN AUTHORIZED DEALER 

CALL TOLL FREE 
800 556-6141 
213 834-2250 CA ONLY 

Vy 

All Davidson MS/DOS 
programs are hard disk 
installable. 

Family & Home Office 
Computing 

System Level: 

Requirements: Ages 3 through 6 
Apple IIGS, IIc, IIc, 
Te (128K & extended 
80-column card) 

IBMEPC’& PS/2 

Tandy 1000 series 

Major compatibles 

Will not run on 
IBM PC Jr. or Apple 
I+ 

IIGS Specific Version 
includes IIGS graphics 
and speech 

10 

5 1/4" to 3 1/2" disk 
exchange available FREE 

Supplement your 
software with workbooks. 

pee;pare 19: 

Suggested Retail 
Price: $29.95 

$49.95 (IGS) 

WD Davidson. 
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Now I'm Talking 

on the IIGS! 

Reading and Me develops a life 
long love of reading as colorful 
clowns help your child build 
early reading skills. 

Program Contents: Reading and Me 
offers twelve sequential learning games 
in four key areas: 
e Readiness = Phonics 
e Alphabet =e Words 

Early Learner Interface: The new 

Davidson Early Learner Interface provides 
easy access to activities and mobility 
within the program. Children can use 

either the mouse or the keyboard to select 
activities and answers. 

_ Printed Graphic Certificate: To 
reward children who complete an : 

activity, a graphic certificate can be printed. 
The certificate includes the child’s name and 
clown illustrations for coloring. 

Additional Features: 
e Playful clown characters 
e Positive reinforcement 
e Optional sound effects 
e Animation and color 
e Double high-resolution graphics 

Reading and Me’ 
. Early Learning 

Software 

Sa Rees Nati uiceey trem eme 

SESS REE yt tte 

“Super, education- 

ally sound program 

for teaching 

reading-readiness 

skills. My kids 

love it!” 

Rev Korman 
Computer Consultant 
Los Angeles Unified 

School District 

System 

Requirements: 

Apple IIGS, IIc+, Ic, 

Ile (128K & extended 

80-column card) 

IBM PC & PS/2 

Tandy 1000 series 
Major compatibles 

Will not run on 

IBM PC Jr. or Apple 
FOR AN AUTHORIZED DEALER 

9 reo All Davidson MS/DOS me Specific Versi | Davidson Specific Version 
800 556-6141 programs are hard disk — includes IIGS graphics 
213 534-2250 CAONLY installable. and speech 

Level: 
Ages 4 through 7 

5 1/4" to 3 1/2" disk 
exchange available FREE 

Supplement your 
software with workbooks. 

See page 19. 

Suggested Retail 
Price: $39.95 

$49.95 (IIGS) 

DD Davidson. 

11 



Grammar Gremlin 
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Grammar Gremlins develops 
language skills by creating an 
entertaining format for your 
children to understand and 
apply rules of grammar. 

Program Contents: The program 
includes more than 60 rules and 600 

practice sentences in four levels of 
difficulty. 

Four Learning Activities: 
e Pretest 

e Build Your Skill 

¢ Grammar Gremlins Game 

e Review Test 

Easy-To-Use Editor: With the editor, 

users can add their own practice “T have never used 
sentences. Any type of lesson that has a any computer 
multiple-choice format can be used with program Wat icas 

the program. oe comprehensive as 

Additional Features: Grammar Gremlins 
e Animation and color e Review and retest feature in dealing with the 
e High-resolution graphics —e Student record-keeping rules of grammar.” 
e Sound effects e Score-keeping Baal Bodare 
e Positive reinforcement e Print capabilities Educational Software Review 

Electronic Learning Magazine 

System Level: 

Requirements: = = Ages 9 through 12 
Apple IIGS, Ic+, Ic, 5 1/4" to 31/2" disk 

He, I+ exchange available FREE 

ae ieee : pee Extend the life of your 
” : software with data disks. 

Major compatibles See page 20. 

Suggested Retail 
Price: $49.95 

FOR AN AUTHORIZED DEALER 

e oe All Davidson MS/DOS avidson 
800 556-6141 programs are hard disk ; 
215 854-2250 CA ONLY installable. BD Davidson. 

12 



Language Arts 

/ Software - 

Spell It Plus’ 
ALAA AAR REREAD AAA AAA DAA AAA ARAAAAAD DDD DD DJ 

Now I'm Talking 
on MS/DOS 
computers! 

Spelling becomes a fun and 
favorite subject as you master 
1,000 commonly misspelled 
words and more than 20 
important spelling rules. 

Program Contents: With five progressive 
learning activities, Spell It Plus teaches 

students 1000 words presented in 50 lists 
grouped in five levels of difficulty. Spell It 
Plus reinforces correct spelling rules and 
patterns. 

Easy-to-Use Editor: 

The editor makes it easy to personalize the 
program by adding your own word lists 
with any of the five activities. Foreign lan 
guage fonts are also available to let you add 
words in French, Spanish, and German to each 

of the programs five activities. 

Additional Features: 

e Animation & sound 

“My students have formed 
teams to learn and practice 
their spelling words using 
Spell It Plus! They don’t 

e Review option want to do anything else. 

e Certificate of Excellence ¢ Record-keeping This tg am is a MUST 

e Word-search puzzle e Print capability for me! 

e High-resolution graphics Nancy Todd 

Eighth Grade 
Communications Teacher 

Shawnee Mission, Kansas 

FOR AN AUTHORIZED DEALER 

CALL TOLL FREE 
All Davidson MS/DOS 

800 556-6 141 programs are hard disk 

213 834-2250 CAONLY installable. 

System Level: 

Requirements: Ages 10 through adult 
Apple IIGS, Ic+, 5 1/4" to 31/2" disk 
IIc, He (128K & 
extended 80- 
column card) 
IBM PC & PS/2 
Tandy 1000 series 
Major compatibles 
Apple II+; C64/128; 

Atari 800XL, 65E, 

130XE; PC Jr. 

owners! Ask for 

Spell It. 

135 

exchange available FREE 

Extend the life of your 
software with data disks. 

See page 20. 

Suggested Retail 
Price: $49.95 

Spell It Owners! 
To upgrade to Spell It Plus, 
send us your Spell It disk only 
and $19.95. Call for more 
information. 

B® Davidson. 



Order Your Davidson Programs Today! 
It's Easy... 

e Call us toll-free at: 

(800) 556-6141 

(213) 534-2250 (CA only) OR 
e Fill out the order form on the 

next page of this insert and mail to: 
Davidson & Associates, Inc. 

3135 Kashiwa St. 

Torrance, CA 90505 

Attn: Consumer Sales 

Five-Year Warranty On All Disks 
If for any reason your disk(s) 
becomes damaged, Davidson will 
replace it FREE. Simply mail us the 
faulty disk(s) only with a note re- 
questing replacement(s). 

Upgrade Your Davidson Programs 
to the NEW Plus Versions 
To upgrade your Math Blaster, 
Word Attack, Alge-Blaster, or 
Spell It to the NEW Plus versions, 

send us your existing disk(s) only 
with a check or money order for 
only $19.95 each. 

The new versions feature animated 
graphics and sound, new arcade- 
style games, Davidson's easy-to- 
use interface, and more data to 

extend the life of your program! 

Customer Service Hotline 
Call us toll-free (7:30 a.m. to 5:00 p.m. PST) for technical assistance 
or for the name of your Authorized Davidson Dealer. 

(800) 556-6141 + (213) 534-2250 

Satisfaction Guarantee 
All Davidson programs offer a 
full satisfaction guarantee. If you 
| are not completely satisfied with 
your purchase, you may ex- 
change it for a replacement 
program (of equal or lesser 
value) OR a full cash refund. 
Send us the program with your 
receipt within 30 days of pur- 
chase and specify your choice of 
program or cash. 

Upgrade Your Apple II Programs! 

NEW Talking IIGS Versions... 
The following programs are avail- 
able in Apple IGS "talking" format. 
e Math Blaster Plus 
e Reading and Me 
e Math and Me 
To upgrade to any one of these 
IIGS formats, send us your existing 
disk(s) only with a check or money 
order for $10.00 each. 

Back-Up Disks 
To receive a back-up of any David- 
son software program, send us 
your registration card with a check 
or money order for $10.00 per 
back-up. 



Order Form 
Call Toll-Free 

B® Davidson. (800) 556-6141 
(213) 534-2250 CA only 
(213) 534-3169 Fax no. 

Ship To: Bill To: (If different from Ship To) 

Name Name 

Company Name (If necessary) Address 

Shipping Address City/State/Zip 

City/State/ Zip Telephone 

Type of Payment 

L] Check LJ Money Order LJVISA/MC Account Number Exp. Date 

Signature 

Disk | Computer 
Qty.| Pg. No. Description Size Type Price Amount 

SUBTOTAL 
6.5% LA county sales tax 

6.0% all other CA counties 
shipping /handling 

$2.50 Ist program, $1.00 each add'l. 
TOTAL 

Send orders to: 

Davidson & Associates, Inc. ¢ 3135 Kashiwa St. ¢ Torrance, CA 90505 

* Commodore 64/128 versions of Math Blaster, Word Attack, Spell It, and Speed 

Reader II are now available for $29.95, a savings of $20.00! 
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Speed Reader II 
DA L A DAA AAA DA AA RA AAA AAA A AAA AA AAA AAA DRA AAD ADR ARARAD ADA DO OD DD DD OO OB | 

Designed by reading 
specialists, Speed Reader II 
helps students increase 
reading speed and improve 
comprehension. 
Program Contents: Speed Reader II 
contains six separate activities and 35 
reading selections. 

Six Learning Activities: 

e Warm-Up Letters e Eye Movement 
e Warm-Up Words e Reading Passages 
e Column Reading e Timed Reading Test 

Easy-To-Use Editor: The editor allows 

users to add their own reading passages. 
After the passages are entered, a built-in 
grade level analyzer determines the level on “Speed Reader II can 
a gone help high school and 
Additional Features: college students 
e Automatic speed computation become faster and more 
e Optional sound effects 
e Optional color 
e Positive reinforcement 
e Computerized tachistoscope 
e Comprehension tests 
e Record-keeping (Macintosh) 

efficient readers, enjoy 
reading more, and 
understand and retain 
what they read.” 

Gwen Solomon 

Family & Home Office 
Computing 

System Level: 

Requirements: Ages 14 through adult 

The, Aer exchange available FREE 

Macintosh 128K, 512K, Extend the age level and 

Plus, SE life of your software with 
IBM PC & PS/2 data disks. See page 20. 

Macintosh Version Tandy 1000 series Suggested Retail 

Major compatibles Price: $49.95 

eoned suehenan ianiee Commodore 64/128 $29.95 (C64/128) 

CALL TOLL All David MS/DOS | Davidson 
800 556-6141 programs are hard disk : 
213 834-2250 ca onLY installable. WD Davidson. 

14 



Read ‘N Roll 
DAA DA AAAAAAAAAAAAAAAADAADDAADAAAAAD SAD DADADADADDSDDDADADDDOAADADS 

Read ‘N Roll’s innovative ap- 
proach to improving reading 
comprehension entertains 
your children as they learn. 

e Identifying the main idea 
e Making inferences 
e Determining the relevant facts 
e Following a sequence of events 
e Building a reading vocabulary 

Vocabulary-Building Bowling 

Game: This action-packed game 
motivates students to learn synonyms 
while they bowl in a colorful bowling 
alley complete with crowd and 
scoreboard! 

Printed Certificate of Excellence: To 

reward outstanding scores, Read ‘N Roll includes an 
option to print out a Certificate of Excellence with 
graphics. 

Additional Features: 

e Student record-keeping with option to print reports 
e Easy-to-use editor 
e Instructional hints for incorrect answers 

e Double high-resolution graphics 

Y Language Arts 
. ‘Software 7 

® Grades & through 6 

“Read ‘N Roll allows 

teachers and parents to 

tailor reading exercises 

aimed at helping 

students better 

understand the contexts 

and inferences of words, 

as well as their 

meanings.” 

Compute Magazine 

. | pera admd : 
oe 

j i. | wanted 

bs | pear tad 

| i. | iitea ed 

art Tod BET hie fo qe. 

CALL TOLL FREE 
800 556-6141 
213 834-2280 CA ONLY 

System 

Requirements: 

Apple IIGS, IIc+, IIc, 

le (128K & extended 

80-column card) 

IBM PC & PS/2 

Tandy 1000 series 

Major compatibles 

Will not run on 

IBM PC Jr. or Apple 
I+ 
All Davidson MS/DOS 
programs are hard disk 
installable. 

Level: 

Ages 9 through adult 

5 1/4" to 3 1/2" disk 
exchange available FREE 

Extend the age level and 
life of your software with 

data disks. See page 20. 

Suggested Retail 
Price: $49.95 

BD Davidson. 

15 



Productivity 

Software 

Homeworker ° 
DA AADAAADAAD DAD AADAADADAAADAADADAAADADD AAD DAADAD DADA DADAADADAADADDADADADDDADADDDADDSL 

Take Charge! With Homeworker 
you can learn the “secret tips” 
to improve your grades and 
better organize your time. 

With Homeworker, students can plan and 
write papers, create flashcards for ' 

memorization tasks, keep track of 
important deadlines, and make “what if” 

predictions while computing grade point 
averages. 

Program Contents: 

e Outliner 
e Word processor 
e Printable flashcard maker 
e Calendar 
e Grade keeper 
e Pop-up calculator 

Deluxe Student Organizer: A program disk, easy-to- “Personally, I think 
follow instructional manual, and How To Study For Homeworker is the ‘wave 
Success book are all packaged in a three-ring binder. of the future.’ I can see a 

Also included: | time when nearly every 
e Pen and highlighter ¢ Divider tabs student will have one. It’s 

e Pencil and ruler e Fact finder fantastic.” 

e Notepad e Personal information section Donna Young 
Software Exploration for Educators 

University of Missouri at 
Kansas City 

System Level: 

Requirements: Ages 12 through 18 

Apple Wise les, Me, 51/4" to 3 1/2" disk 
Ile (128K & extended exchange available FREE 
80-column card) : 

IBM PC & PS/2 2 ego peaieae 
Tandy 1000 series ue 

Major compatibles =, Davidson MS/DOS 
Will not run on programs are hard disk 

von dnGeneuan teases IBM PC Jr. or Apple _ installable. 

CALL TOLL FREE sas 
800 556-6141 
215 834-2250 CA ONLY BD Davidson. 

16 



Classmate” 

With this comprehensive 
classroom management tool, 
teachers can organize their 
class records, giving them 
time to do what they do 
best—teach! 

Program Contents: Classmate keeps 
track of grades, attendance, and 

individual comments for classes up to 51 
students. The program also computes 
final grades based on total points and/or 
weighted averages, graphs distribution 
curves, and prints reports. 

Program Activities: 

Enter Class Roster 

¢ Input an unlimited number of 

classes 

° Sort by name or ID number 
© Print class roster 

® Transfer names/ comments to new 

file 

Revise Class Roster 
° Add, drop, or revise, then sort 

names 

° Print revised class roster 

Compute Weighted Averages 
° Compute grade averages 

Analyze Statistics 

ENTER CLASS ROSTER 

REVISE CLASS ROSTER 

EXAMINE 

COMPUTE WEIGHTED AVERAGES 

ANGLYZE STATISTICS 

EXIT PROGRAR 

Po Tue Peet een Cb tan | 

FOR AN AUTHORIZED DEALER 

CALL TOLL FREE 
800 556-6141 
213 834-2250 CA ONLY 

-ADDAAAAAAAAAAAAA AAA AABAAA AAA AAA AA AAA AAA AAA AAA AAA AAAAAA AA AAA, 

Enter /Revise Students’ Records 
e Enter grades under specified 
headings 

° Record attendance 
e Enter personal comments about 

each student 
° Correct or delete assignments, titles, 

or marks ; 

Examine /Print Students’ 
Records — 
° Rank students by grade 

Print all records : 
° List attendance and missing work 

records 

System 
Requirements: 

Ile, [I+ 

IBM PC & PS/2 

Will not run on 

IBM PC Jr. 

All Davidson MS/DOS 
programs are hard disk 
installable. 

17 

Apple IIGS, Ic+, IIc, 

Tandy 1000 series 

Major compatibles 

Educators 

“Classmate’s special 

features include easy 

editing and a 

comfortably large 
number of characters 

you can enter for 

assignment names. 

The manual is 

informative and easy 

to follow.” 

InCider Magazine 

Level: 

For Teachers 

5 1/4" to 3 1/2" disk 
exchange available FREE 

Suggested Retail 
Price: $49.95 

DD Davidson. 



Mathematics 

Videos E ccy 
LAD ADAAAAABAABABAAAAAAAB AAD ADALAAADADADAAAAD AD DADDADAAAAADDA DDS 

“In Search of the 

Missing Numbers”’ 
Addition and Subtraction (Ages 6-9) 

Run Time: 60 Minutes (two 50-minute 

segments separated by an intermission) 

Children will delight in following Brad and 
Melissa into the fantasyland of Blasteria as 
they search for the missing numbers. 
Along the way, our heroes befriend many 
colorful characters as they use addition Winner 
and subtraction to help solve the mystery | New York International Film 

AND save Blasteria from the evil number- | and Video Festival Awards 

snatching Fallover Crumbwell. = 

“Math Rock Countdown” 
Multiplication and Division (Ages 9-12) 
Run Time: 50 Minutes (two 25-minute 

segments separated by an intermission) 

Move over MTV! Anna and Louis, math trivia 

contest winners, attend the taping of “Math Rock 
Countdown,” America’s top-rated new music show 
Join K.C. Greasum, roving reporter Todd Toady, 
zany producer Sterling Pinchpenny, and a whole 

ea cast of live entertainers in a musical 
countdown that will improve everyone's 

¢ multiplication and division skills. AvailableFormat: 

VHS/Full Color 

Special Offer! 
Regular price $19.95 
now only $14.95 each! 

Order direct from Davidson 
and receive $5.00 off the 
regular retail price. 

For more information CALL TOLL FREE | 

call our video hotline, 800 545-7677 ee Davidson. 
213 326-7444 CA ONLY 

18 



Language Arts 

Wiathematics 

Workbooks 

Workbooks 
i Dpiititip i Ai pa AAA Ahaha hapa ha hhh hahah ha hahha ahha b ahh eh he eo oo of 

To enhance your child’s 
education at home or at school, 

Davidson offers a series of 

workbooks that can be used 

alone or in conjunction with 
Davidson software. 

° Designed by educators 
¢ Teaches and reinforces math, reading 
and vocabulary building skills 

¢ Includes captivating illustrations on 
every page 

¢ Develops higher level thinking skills 
¢ Offers blackline reproducible pages 

The 33-workbook series includes the following. 
Each grade and subject area represents a 
separate workbook. 

Math Blaster™ (Math Blaster 

Plus™ ) Workbooks 

Math and Me™ Workbooks 

Preschool, Book 1 

Grade 1, Addition Preschool, Book 2 

Grade 1, Subtraction Kindergarten, Book 1 

Grade 1, Addition & Subtraction Kindergarten, Book 2 
Grade 2, Addition First Grade, Book 1 

Grade 2, Subtraction First Grade, Book 2 

rade 2, Addition & Subtraction 

ae 3, Multiplication Word Attack™ (Word Attack 

Grade 3, Division Plus™ ) Workbooks 

Grade 3, Multiplication & Division Grade 2, Adjectives 
Grade 4, Multiplication Grade 2, Nouns 

Grade 4, Division Grade 2, Verbs 

Grade 4, Multiplication & Division Grade 3, Adjectives 

Reading and Me™ Workbooks eS 
Preschool, Book 1 Grade 3, Verbs 
PreschooiBegk> Grade 4, Adjectives 

ude Grade 4, Nouns 
Kindergarten, Book 1 
Kindergarten, Book 2 

Grade 1, Book 1 

Grade 1, Book 2 

CALL TOLL FREE 
800 556-6141 
213 834-2250 CA ONLY 

Grade 4, Verbs 

Suggested Retail Price: 

$4.95 each (Math Blaster, Word Attack) 

$3.95 each (Math and Me, Reading and Me) 

BD Davidson. 

19 



Data Disks 

Data Disks 
Li AA ADA AAA DADRA ARADO AAA RRA RADAR AAA AAA AAA A AA AAD AAD DDD DD OO OO J 

These supplemental disks offer additional data 
to add longevity to your software program. 

You must have the program disk to use the data disks. 

Spell It Plus!” Alge-Blaster™ 

© Grades 1-2 | ¢ Monomials & Polynomials 
© Grades 3-4 ° Factoring 

© Grades 5-6 e Equations 

Word Attack!™ Foreign Language Data Disks” 

Word Attack Plus!™ : For use with Word Attack Plus only 
° Grades 2-3 ¢ Beginning French, Level 1 
© Grades 4-5 ¢ Beginning French, Level 2 
© Grades 6-7 ¢ Beginning Spanish, Level 1 
° Grades 8-9 ® Beginning Spanish, Level 2 

e SAT Prep ; : : 
© Rodis Prctes Attention Educators! Combine 

Textbooks With Software... 
Speed Reader II™ 
e Grades 5-6 Scott, Foresman Series Data Disks 

© Grades 7-8 Supports the Scott, Foresman. 

© Grades 9-12 Textbook Series 

* College through Adult For use with Word Attack (Apple only, 

Grammar Gremlins” or Word Attack Plus (Apple, IBM) 

| © Grade 3, Hidden Wonders/ 
® Grade 3 

Golden Secrets 
° Grade 4 

® Grade 4, Sea Treasures 
® Grade 5 
Cds ° Grade 5, Sky Climbers 

° Grade 6, Star Flight 

Read ’N Roll” ts 

° Grades 3-4 “With Davidson’s data disks, now 
° Grades 5-6 even my first and second graders can 
° Grades 7-8 use Spell It Plus!” 

Betty Ann Heineman 
Resource Specialist 

Suggested Retail 
Price: $19.95 each 

FOR AN AUTHORIZED DEALER 

CALL TOLL FREE 

800 556-6141 : 
215 834-2250 CA ONLY BD Davidson. 

20 



Award-Winning Software 

Davidson's educational software is internationally recognized for its 
innovative approach to learning. Noted for its effectiveness, Davidson 
software challenges and motivates by addressing all points along the 
learning continuum—both higher and lower order thinking skills. 

Math Blaster Plus™ /Math Blaster™ 

e Parents Choice Award/ Parents Choice Foundation 
e Highly Recommended/ Media & Methods Awards Portfolio 
e Rated: Excellent/Florida Center for Instructional Computing 
e Highly Recommended/ Apple IIGS Buyer's Guide 
e Outstanding Educational Product/ Parents Choice Foundation 
e Best Selling New Educational Product/ Softsel/Businessweek 
e Certified Platinum Award (Over 250,000 sold)/Software Publishers Association 
e Software Excellence Award/ Nibble Magazine 

Math and Me™ 
e Rating: A/Software Reports: A Guide to Educational Software 
e Highly Recommended /Survey of Early Childhood Software 
e Highly Recommended/A+ Magazine 
e Software Excellence/High Scope Resource 
e Rated: Excellent/Florida Center for Instructional Computing 

Homeworker™ 
e Best Secondary School Education Program/ Software Publishers Association 
e Critics’ Choice Award/ Family Computing Magazine 
e Parents Choice Award/ Parents Choice Foundation 
e Highly Recommended/Media & Methods Awards Portfolio 

Spell It™ 

e Critics’ Choice Award/ Family Computing Magazine 
e Grade: A/Software Reports: A Guide to Educational Software 
e Highly Recommended/Media & Methods Awards Portfolio 

Word Attack Plus™ /Word Attack™ 

e Critics’ Choice Award/Family Computing Magazine 
e Certified Gold Award (Over 100,000 sold)/ Software Publishers Association 

e Top Seller, Education/Home Category / Software Retailing 
e Excellent: All Categories/Info World 

Speed Reader™ 

e Software of the Year/ Gisetonte Computer Learning Magazine 
e Best of the Year/Learning Magazine 
e Certified Silver Award (Over 50,000 sold) / Software Publishers Association 

Alge-Blaster™ 

e Highly Recommended/Curriculum Product Review 
e Highly Recommended /Electronic Learning Magazine 
e Grade: A/ Software Reports: A Guide to Educational Software 
e Highly Recommended /Compute’s! Gazette 
e Certified Gold Award (Over 100,000 sold)/ Software Publishers Association 

Read ’N Roll™ 
e Rated: Excellent/ Florida Center for Instructional Computing 
e Highly Recommended/ Media & Methods Awards Portfolio 
e Highly Recommended/InCider Magazine 

Réading and Me™ ; 

e Highly Recommended/InCider Magazine ee Davidson. 
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